
ЗАНЯТИЕ 2

1. Создание нового проекта
2. Задание последовательности горизонтов.
3. Настройка структуры данных.
4. Загрузка (импорт) данных в проект.



Создание проекта

Запустите RMS 7.4 через меню Пуск => Все программы 
=> Roxar => RMS 7.4, или двойным щелчком ЛКМ на 
пиктограмме RMS 7.4, расположенной на рабочем столе. В 
появившейся панели можно выбрать необходимые для работы 
модули. OK.

Если IRAP RMS запущен первый раз, то появится 
панель Unit set selector (Выбор единиц измерения). 
По умолчанию – Metric. При включении опции 
Use as defaults for new projects

После нажатия кнопки ОК создастся новый пустой 
проект. Выбранную систему единиц измерения 
можно увидеть в нижней части панели Project.

выбранные единицы измерения будут использоваться для всех новых проектов 
и эта панель появляться не будет. Также, эту панель можно вызвать из меню 
Options => Unit Set в панели Project. 



Сохранение проекта

Нажав на контейнере Project правой 
клавишей мыши, вызовите его меню и 
выберите Information... В появившейся 
панели введите информацию о новом 
проекте.

Сохраните созданный 
пустой проект через 
меню File => Save 
Project as..., указав 
место где должен быть 
сохранен проект, и его 
название. 

Проект сохраняется в виде отдельной папки с указанным названием. Для 
удобства работы рекомендуется при сохранении проекта использовать 
расширение .pro. 
Теперь закройте проект и программу, выбрав в панели Project: File => Exit.



Загрузка проекта

Вновь запустите IRAP RMS.
Для загрузки созданного проекта в панели Project 
выберите File => Load Project, и в появившейся 
панели укажите местонахождение и название 
проекта.

Если Вы недавно работали с проектом, то его 
можно загрузить, выбрав из списка 
последних запущенных проектов. Этот 
список доступен из меню File панели Project.



Задание последовательности 
горизонтов

После создания нового проекта 
необходимо задать 
последовательность основных 
горизонтов и изохор. Горизонты – 
это границы между пластами. Они 
бывают интерпретированные 
(interpreted) и рассчитанные 
(calculated) – подробнее о каждом 
типе горизонтов сказано на 
следующих слайдах. Изохоры – это 
слои, определяющие толщины 
между соседними горизонтами.
Структура учебного месторождения 
изображена на рисунке.
Сплошными линиями показаны 
интерпретированные горизонты 
(Top1, Bot2), пунктирными – 
рассчитанные (Bot1,Top2), красная 
сплошная линия - разлом.
H1, Hclay, H2 – изохоры.

Fault



Задание последовательности 
горизонтов

Некоторые замечания:
• Названия горизонтов и изохор должны быть уникальными.
• В названиях горизонтов и изохор могут использоваться только английские 
буквы. 

• В названиях горизонтов и изохор не должны содержаться пробелы и знаки 
математических операций.

• Каждый моделируемый интервал (пласт, пропласток, объект раз-работки, 
стратиграфический интервал и т.п.) должен быть представлен в структуре 
месторождения в виде последовательности трех элементов: «горизонт» – 
«изохора» - «горизонт», трактующихся как «кровля» - «мощность» - «подошва» 
этого интервала.

• Горизонты могут быть двух типов:
- Interpreted horizon (интерпретированный горизонт) – это горизонт, 
поверхность которого строится на основании исходных данных с 
использованием алгоритмов картопостроения. Процесс построения 
контролируется пользователем.

- Calculated horizon (рассчитанный горизонт) – это горизонт, поверхность 
которого строится автоматически на основании скважинных данных 
относительно (или между) поверхностей интерпретированных горизонтов.



Задание последовательности 
горизонтов

Запустите RMS 7.4 и загрузите созданный пустой 
проект. В панели Project выберите Horizon => 
Horizon Administration...

Открывшаяся панель Horizon Administration предназначена для 
задания последовательности горизонтов и изохор. С помощью 
этой панели необходимо задать следующую последовательность:

H_1

H_clay

Top_2

H_2

Bot_2

Top_1

Bot_1



Задание последовательности 
горизонтов

Последовательность горизонтов задается с помощью 
кнопок, находящихся в правой части панели Horizon 
administration...
Оперируя кнопками, необходимо получить 
изображенную на рисунке последовательность 
горизонтов.

Добавить интерпретированный гор-т
Добавить рассчитанный горизонт
Добавить / разбить изохору
Автовставка
Изменить тип горизонта

Удалить интерпретированный горизонт
Удалить рассчитанный горизонт
Удалить изохору
Сортировать горизонты
Определить цвета горизонтов

Название добавляемого горизонта
Добавление сверху / снизу
Разделить изохору на две части в 
заданном соотношении
Кнопка «Обновить список 
горизонтов». Для принятия 
любых изменений нужно 
обязательно нажимать на эту 
кнопку!



Задание последовательности 
горизонтов

Последовательность действий:
1. Активируйте кнопку Add / split isochore. В строке 

Name введите название изохоры Above_Top_1. 
Нажмите кнопку Update horizon list.

2. Активируйте кнопки Add interpreted horizon, и 
кнопку Below. В строке Name введите название 
интерпретированного горизонта Top_1. Нажмите 
кнопку Update horizon list.

3. Вновь активируйте кнопку Add / split isochore. 
Следите за тем, чтобы были активированы кнопки
One и Below, а также за тем, чтобы в списке уже существующих горизонтов был 
выбран только последний. В строке Name введите название изохоры H_1.

4. Активируйте кнопку Add calculated horizon. Следите за тем, чтобы были 
активированы кнопки One и Below, а также за тем, чтобы в списке была выбрана 
последняя созданная изохора. В строке Name введите название  Bot_1.

5. Аналогичным образом добавьте все остальные горизонты и изохоры согласно 
рисунку.

После завершения нажмите кнопку OK.



Задание последовательности 
горизонтов

После закрытия панели Horizon administration... 
раскройте список Horizons, в котором можно увидеть 
созданные горизонты и изохоры. Внутри списков 
горизонтов и изохор находятся пустые пиктограммы 
данных, которые по умолчанию могут быть 
использованы в проекте. Если установлена сортировка 
по типам данных, то отключите ее (Horizons => List by 
data type...).

Cохраните проект.



Настройка структуры 
данных

В некоторых случаях, структура данных, предлагаемая по умолчанию, может 
быть не оптимальной: содержать много ненужных типов данных или наоборот, не 
позволять использовать какие-то определенные типы данных. В этих случаях 
требуется настройка структуры данных проекта.

Для добавления типов данных: в 
меню контейнера Horizons 
выберите опцию Add data types… 
В верхней части появившейся 
панели выберите объект, для 
которого Вы будете добавлять типы 
данных (интерпретированный 
горизонт, рассчитанный горизонт 
или изохора). Из списка типов 
данных можно выбрать тот, 
который хотите добавить (при 
необходимости изменить его 
название). После добавления 
необходимых типов данных – 
Apply или OK.



Добавление типов данных

1. Добавьте к объектам Interpreted horizon типы данных Contours и Residual 
lines, поменяв название последнего на Contour_OWC;

2. Добавьте к объектам Isochore тип данных Zero polygons.



Удаление типов данных

Для удаления типов данных: в меню контейнера Horizons выберите опцию Remove types… 
В верхней части появившейся панели выберите объект, у которого Вы будете удалять типы 
данных. Из списка типов данных, выберите тот/те, которые хотите удалить. Нажмите кнопку 
Ok или Apply. Удалите у объектов Interpreted horizon все временные типы данных (Time 
surface, Time lines). Замечание: Удаляя типы данных, Вы 

удаляете всю информацию, которая 
может содержаться в данных этого 
типа, имеющихся в проекте.
Отменить удаление типов данных 
нельзя.

В результате должна получиться 
структура данных, показанная на 
рисунке:

Далее сохраните проект.



Загрузка (импорт) 
данных в проект.



Описание форматов: 
ASCII IRAP Classic, ASCII Internal Points

9.05 2.03 3.25
7.29 1.90 3.20
5.00 1.79 3.42
3.04 1.64 3.92
1.80 1.53 4.34

Формат ASCII IRAP Classic фактически представляет собой XYZ-файл – три столбца с 
координатами X, Y, Z. X Y Z

В формате ASCII Internal Points Также можно задавать дополнительные столбцы, 
предварительно описав их в заголовке формата.

String Horizon
String Well
457448.150 6786056.900 1899.910 TopTarbertC B-1
456078.750 6787074.150 2017.410 TopTarbertC B-12
458065.450 6786669.650 1878.260 TopTarbertC B-15
456802.550 6786275.800 1883.710 TopTarbertC B-17

Тип данных в столбце (может 
быть String, Float, Integer, Bool)

X Y Z Horizon Well

Название параметра в столбце (к примеру, в случае 
набора точек для изохоры здесь может стоять такой 
параметр, как пористость)



Загрузка данных по горизонту Top_1

Результаты структурной интерпретации 3D сейсмики (Файл «3D.txt»)
В меню пустой пиктограммы 3d lines в списке горизонта Top_1 выберите опцию Import -> ASCII Irap 
Classic. В появившейся панели укажите местоположение и название импортируемого файла.

После импорта данных, их пиктограммы станут цветными, а сами данные можно 
будет визуализировать. 

Аналогичным способом импортируйте следующие типы данных:
Результаты структурной интерпретации 2D сейсмики (Файл «2D.txt») – 
пиктограмма 2d lines.
Контуры (результат оцифровки бумажных карт) (Файл «top_contours.txt») – 
пиктограмма Contours.
Контуры разломов (Файл «fault_line_top.txt») – пиктограмма Depth fault polygons.

Посмотреть 
информацию о 
данных можно, 
выбрав в меню 
их пиктограммы 
опцию 
Information.



Загрузка данных по горизонту Top_2

После визуализации всех данных, загруженных в горизонт Top_1 мы получим 
подобное изображение.

Для поверхности Bot_2 
имеются только контуры 
разломов. Загрузите их в 
горизонт Bot_2, тип данных -  
использовав файл 
fault_line_bot.txt (формат – 
ASCII IRAP Classic).



1.0
Oil
PROD10 4485.5 6988.4
5
LITO DISC 0 Clay 1 Sand 
ZONELOG DISC 0 A 1 H1 2 H_clay 3 H2 4 B 
Aps unit1 scale1
PORO unit1 scale1
SOIL unit1 scale1
4485.525400 6988.431200 1890.000000 0.000000 0.000000 0.214300 0.028600 0.000000
4485.525400 6988.431200 1895.000000 0.000000 0.000000 0.214300 0.028600 0.000000
4485.525400 6988.431200 1895.343600 0.000000 1.000000 0.214300 0.028600 0.000000
4485.525400 6988.431200 1896.343600 0.000000 1.000000 0.233900 0.067600 0.000000
4485.525400 6988.431200 1897.343600 1.000000 1.000000 0.657600 0.178900 0.746100

Загрузка скважин:
обзор форматов

- версия формата
- тип флюида

- название и координаты устья скважины

- описание 4-го столбца - дискретной кривой
- описание 5-го столбца

- описание 6-го столбца (Альфа-ПС) – непрерывной кривой
- описание 7-го столбца (кривая пористости)

- описание 8-го столбца (кривая нефтенасыщенности)

X Y Z LITO ZONELOG Aps PORO SOIL

Название 
кривой

Тип кривой 
(дискретная)

Формат ASCII RMS Well

- общее количество кривых
Описание 
соответствия 
значений 
кривой и 
названий (в 
данном случае 
ненулевому 
значению 
кривой 
соответствует  
коллектор, а 
нулевому 
неколлектор).



Загрузка скважин:
обзор форматов

Формат LAS 2.0 (файлы типа .LAS)
# Produced by RMS 7.4
~VERSION
VERS        .          2.0 :CWLS Log Ascii Standard - Version 2.0
WRAP .          NO :One line per depth step
DLM         .          SPACE :Delimiting character (SPACE, TAB or COMMA)

~WELL
# Keyword.Unit         Data Type               Description
# ------------         ---------               -------------------------------
STRT        .m         1920.00 :First index value
STOP        .m         1979.60 :Last index value
STEP        .m         0.00 :Step of index
NULL       .          -999.25 :NoValue
WELL       .          PROD10 :Well name
FLD          . :Field name
RKB         .m         0.00 :RKB

~PARAMETER
# Keyword.Unit         Value                   Description
# ------------         ---------               -------------------------------
XWELL       .m         4485.50                 :X-coordinate of Well Head
YWELL       .m         6988.40                 :Y-coordinate of Well Head

Раздел VERSION – 
содержит 
информацию о 
версии LAS-файла.

Раздел WELLS – информация о 
скважине – начальная и конечная 
глубина замеров (STRT, STOP), шаг 
квантования кривых (STEP), 
нулевое значение (NULL), название 
скважины (WELL), высота 
роторного стола (RKB).

Раздел PARAMETER – 
координаты устья скважины 
(XWELL, YWELL).



Загрузка скважин:
обзор форматов

~CURVE
# Name.Unit                                    Curve Description
# ---------                                    -----------------
MD .m :1 Index
ZONELOG . :2
LITO . :3
APS . :4
PORO . :5
SOIL . :6

~ASCII
1920.00       0             0             0.21430001    0.0286        0
1920.20       0             0             0.21430001    0.0286        0
1920.40       0             0             0.21430001    0.0286        0
1920.60       0             0             0.21430001    0.0286        0

Раздел CURVE – информация о 
кривых, содержащихся в LAS-файле. В 
данном примере в файле содержится 
информация об измеренной глубине 
(MD), а также о кривых: стратиграфии 
(ZONELOG), литологии (LITO), 
альфа-ПС (APS), пористости (PORO), 
нефтенасыщенности (SOIL).

Раздел ASCII – собственно сами 
вышеуказанные кривые. Первый 
столбец – глубина MD, последний – 
кривая SOIL.

Формат LAS 2.0 (файлы типа .LAS)



Загрузка скважин:
обзор форматов

Формат LAS 2.0 (Дополнительный файл .XYZ)

4475.00      6975.00      1889.76      1920.00 
4475.00      6975.00      1890.76      1921.00 
4475.00      6975.00      1891.76      1922.00 
4475.00      6975.00      1892.76      1923.00 
4475.00      6975.00      1893.76      1924.00 
4475.00      6975.00      1894.76      1925.00

В данном случае в дополнительный 
файл входят следующие столбцы:

- X (х-координата точки)
- Y (у-координата точки)
- MD (измеренная глубина точки)
- TVD (абсолютная глубина точки)

В нашем учебном месторождении дополнительная информация о траектории скважины 
содержится в отдельном файле, имеющим название <WELL>.XYZ, где <WELL> - 
название скважины. ВАЖНО! Названия самого LAS-файла и дополнительного файла 
должны совпадать.



Загрузка скважин. 
Шаг 1.

Для загрузки скважин выберите: Wells => Import => 
Import trajectories/logs/annotations...
В открывшейся панели выберите:
Items: Trajectory with logs;
Format: LAS.
Нажмите Next.



Загрузка скважин. 
Шаг 2.

В данной панели нажмите Select. В 
появившейся панели введите *.las и нажмите 
Enter чтобы отфильтровать все имеющиеся 
файлы. Далее выделите скважины, которые 
необходимо загрузить в проект (W1-W7, 
PROD8-PROD15), нажмите OK. Перейдите 
к следующему шагу, нажав Next.



Загрузка скважин. 
Шаг 3 и 4.

В разделе Location of surveys 
(местонахождение замеров по скважинам, в 
т.ч. траектории) активируйте опцию 
Defined in separate file (заданы в 
отдельном файле). Нажмите Next.

Следующая панель предназначена для 
задания ключевых слов (названий разделов) 
Ваших LAS – файлов. Оставьте все по 
умолчанию. Нажмите Next.



Загрузка скважин. 
Шаг 5.

Данная панель предназначена для задания 
формата загрузки траектории. Траектория, 
как упоминалось выше, задана в отдельном 
файле .XYZ. Необходимо создать формат 
для загрузки этого файла. Нажмите 
Create/Edit format...

В появившейся панели 
Import/export utilities в закладке 
Trajectory formats содержится 
информация о существующих 
форматах. Нажмите Create.



Загрузка скважин. 
Шаг 6.
1. Задайте название нового формата XYZ. Нажмите 
Next.
2. В разделе Well head оставьте все по умолчанию, 
т.к. информация о заголовках скважин содержится в 
самих LAS-файлах. Нажмите Next.
3. В разделе Surveys задаются номера 
соответствующих столбцов в нашем файле .XYZ. В 
строке Measured depth in column добавьте цифру 4 
(т.к. шкала MD содержится в 4-м столбце). 
Нажмите Next.

1

2
3



Загрузка скважин. 
Шаг 7.

В разделе Drilling Data оставьте все по умолчанию, 
т.к. у нас не никаких дополнительных данных о 
бурении. Нажмите Next.

В последней панели указывается символ, 
разделяющий столбцы – пробел или табуляция. В 
нашем случае это пробел.
Нажмите OK.



Загрузка скважин. 
Шаг 8.

Вернувшись в панель Import trajectory with logs 
укажите созданный формат, и в строке File name 
extension задайте расширение файла xyz. 
Нажмите Next.

Далее в разделе RKB сотрите значения строк 
LAS keyword и Default (m). Нажмите Next.



Загрузка скважин. 
Шаг 9.

В последней панели поверьте 
правильность задания всех параметров и 
нажмите Execute. Если все сделано 
правильно, то скважины должны 
загрузиться.



Визуализация 
скважин

Если все сделано 
правильно, то 
скважины должны 
загрузиться в 
проект. После их 
визуализации в окне 
3D-визуализации 
должна получиться 
подобная картинка:

Сохраните проект.



Конвертирование кривых

Так как мы загрузили скважинные данные из LAS-файлов, то у нас 
все кривые загрузились как непрерывные. Необходимо перевести 
кривые ZONELOG  и LITO в дискретный формат.

В появившейся панели необходимо 
выбрать все скважины, это уже 
сделано по умолчанию.
Нажмите Next.

Выполните: 
Wells => 
Calculators => 
Log 
operations...



Конвертирование кривых

Данная панель предназначена для осуществления разнообразных операций над 
скважинными кривыми. Нам необходимо конвертировать кривые ZONELOG и LITO в 
дискретный формат.

Выберите:
Log type: Discrete;
Operation type: Log conversion;
Create discrete log from: ZONELOG;
Output log: ZONELOG_DISCR.



Конвертирование кривых

Теперь нужно добавить операцию для кривой LITO. Нажмите 
Create и OK.
Для второй операции задайте исходную кривую LITO, а 
конвертированную кривую – LITO_DISCR. Нажмите Next.



Конвертирование кривых

Далее необходимо задать операции для удаления первоначальных 
непрерывных кривых. Создайте Operation 3 и Operation 4, укажите 
в них Operation Type – Delete log, а в строке Output log задайте 
кривые ZONELOG и LITO соответственно.



Конвертирование кривых

В последней панели 
проверьте заданный 
операции и  нажмите 
Execute.
Ваши непрерывные кривые 
конвертируются в 
дискретные.



Просмотр информации по 
скважинам

Просмотр информации по 
скважинам: нажатие ПКМ на 
контейнере Wells => Information.

Область Total number of items:
1. Число скважин
2. Сколько из этих скважин – 

ответвления
3. Число пробуренных
4. Число запланированных 

траекторий
5. Число скважинных кривых
6. Число объектов бурения
7. Число групп объектов
8. Число кластеров

1 2

3 4
5

6 7
8



Просмотр информации по 
траекториям скважин

Просмотр информации по траекториям скважин: разверните контейнер Wells, 
затем список скважины => ПКМ на траектории => Trajectory properties...

1 2 3 4 5 6 7

1. Измеренная глубина (MD).
2. Отклонение скважины от 

вертикали (Incl)
3. Азимут отклонения (AZ)
4. Координаты по X (East (X))
5. Координаты по Y (West (Y))
6. Абсолютная отметка по Z 

(TVD)
7. Прочие параметры траектории



Просмотр информации по 
скважинным кривым

Просмотр информации по скважинным кривым: разверните контейнер Wells, 
затем список скважины => ПКМ на траектории => Logs...

1. Таблица скважинных кривых
2. Число загруженных кривых
3. Операции с наборами кривых 

(Log runs)
4. Меню работы с таблицей кривых 

(вызывается нажатием ПКМ). 
Можно копировать, 
редактировать, экспортировать 
таблицу...

3

2

4

1



Задание соответствия между 
изохорами и кривой стратиграфии

В левой нижней части панели Horizon administration укажите в качестве кривой 
стратиграфии ZONELOG_DISCR. После этого в столбце Zone log задайте изохоре H_1 
код 1, изохоре H_clay код 2, изохоре H_2 код 3. Тем самым Вы сообщите программе 
соответствие между значениями кривой и заданными нами изохорами.



Спасибо всем, кто 
справился


